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Manuals for This Machine
Read this manual carefully before you use this machine.

Refer to the manuals that are relevant to what you want to do with the machine.

• Media differ according to manual.

• The printed and electronic versions of a manual have the same contents.

• Adobe Acrobat Reader/Adobe Reader must be installed in order to view the manuals as PDF files.

• A Web browser must be installed in order to view the html manuals.

About This Machine

Before using the machine, be sure to read the section of this manual entitled Safety Information.

This manual introduces the machine’s various functions. It also explains the control panel, preparation
procedures for using the machine, how to enter text, how to install the CD-ROMs provided, and how
to replace paper, toner, and other consumables.

Troubleshooting

Provides a guide for resolving common usage-related problems.

Copy Reference

Explains Copier functions and operations. Also refer to this manual for explanations on how to place
originals.

Facsimile Reference

Explains Facsimile functions and operations.

Printer and Scanner Reference

Explains functions and operations for the machine's printer and scanner unit.

Network and System Settings Guide

Explains how to connect the machine to a network, configure and operate the machine in a network
environment, and use the software provided. Also explains how to change User Tools settings and
how to register information in the Address Book.

Security Reference

This manual is for administrators of the machine. It explains security functions that you can use to
prevent unauthorized use of the machine, data tampering, or information leakage. For enhanced
security, we recommend that you first make the following settings:

• Install the Device Certificate.

• Enable SSL (Secure Sockets Layer) Encryption.

• Change the user name and password of the administrator using Web Image Monitor.

For details, see "Setting Up the Machine", Security Reference.
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Be sure to read this manual when setting the enhanced security functions, or user and administrator
authentication.

Other manuals

• Quick Reference Copy Guide

• Quick Reference Printer and Scanner Guide

• Quick Reference Fax Guide

• Manuals for DeskTopBinder Lite

• DeskTopBinder Lite Setup Guide

• DeskTopBinder Introduction Guide

• Auto Document Link Guide

• Manuals provided are specific to machine types.

• The following software products are referred to using general names:

Product Name General name

DeskTopBinder Lite and DeskTopBinder Professional*1 DeskTopBinder

*1 Optional
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Notice

Important

In no event will the company be liable for direct, indirect, special, incidental, or consequential damages
as a result of handling or operating the machine.

For good copy quality, the supplier recommends that you use genuine toner the supplier.

The supplier shall not be responsible for any damage or expense that might result from the use of parts
other than genuine parts form the supplier with your office products.
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates points to pay attention to when using the machine, and explanations of likely causes of paper
misfeeds, damage to originals, or loss of data. Be sure to read these explanations.

Indicates supplementary explanations of the machine's functions, and instructions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find further relevant information.

[ ]
Indicates the names of keys that appear on the machine's display.

[ ]
Indicates the names of keys on the machine's control panel.

Notes

Contents of this manual are subject to change without prior notice.

Colors on color keys or the color circle may differ slightly from the colors of actual copies.

The color samples in this manual may differ slightly from the colors of actual copies.

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Depending on which country you are in, certain units may be optional. For details, please contact your
local dealer.
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Laws and Regulations

Legal Prohibition

Do not copy or print any item for which reproduction is prohibited by law.

Copying or printing the following items is generally prohibited by local law:

bank notes, revenue stamps, bonds, stock certificates, bank drafts, check, passports, driver's licenses.

The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing certain
items, consult with your legal advisor.

This machine is equipped with a function that prevents making counterfeit bank bills. Due to this function
the original images similar to bank bills may not be copied properly.
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Model-Specific Information
In this manual, model-specific information is indicated by the following marks:

Indicates information that is specific to the 220 to 240 V model.

Indicates information that is specific to the 120 V model.

• Check the label on the right side of the machine to identify the model.

BMH005S

• Dimensions in this manual are given in two units of measure: metric and inch. If your machine is the
220 to 240 V model, refer to the metric units. If your printer is the 120 V model, refer to the inch units.
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Display 
This section describes configuration using the display when the printer function is selected.

• Do not touch the display.

The following screen appears when you turn on the printer.

BMH001S

1. Operational Status or Messages

Displays the printer status or the messages.

2. [JobReset]

Press to cancel the current print job. If you press it when the machine is offline and Hex Dump is selected,
Hex Dump is canceled.

3. [Menu]

Press to display the menu to select the following options:

• Form Feed

Prints all the data left in the machine's input buffer.

• Show Error Log

Displays the error logs of print jobs that are sent from a computer.

Reading the Display and Using Keys

This section explains how to read the display and using the selection key for the initial display.

1

2

34

BMH002S

11



1. [OK] key

Press to set a selected item or entered numeric value.

2. [Escape] key

Press to cancel an operation or return to the previous display.

3. Scroll keys

Press to move the cursor to each direction one by one.

When [ ] [ ] [ ] or [ ] appears in this manual, press the scroll key of the same direction.

4. Selection keys

Correspond to items at the bottom line on the display.

Example: initial printer display

• When the instruction "press [JobReset]" appears in this manual, press the left selection key.

• When the instruction "press [Menu]" appears in this manual, press the right selection key.
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Setting Paper on the Bypass Tray
This section gives instructions for setting paper on the bypass tray.

For details about paper size and paper type, see "Recommended Paper Sizes and Types", About This
Machine.

• Paper sizes that can be loaded onto the bypass tray are 90-305 mm (3.55-12.00 in.) vertical, and
148-600 mm (5.83-23.62 in.) horizontal.

• When paper larger than 600 mm (23.62 in.) in length is used, the paper may become wrinkled, may
not be fed into the machine, or may cause paper jams.

• The machine can automatically detect the following sizes as regular size copy paper:

•  A3 , A4 , A5

•  11 "  17 " , 81/2 "  11 " , 51/2 "  81/2 " 

• If you want to use the size of paper other than the above, be sure to specify the size.

• The following functions are disabled when printing from the bypass tray:

• Duplex printing

• Auto Tray Select

• Auto Tray Switching

• Rotating Collate

• Certain types of OHP transparencies for color printing cannot be used. For details about types that
can be used, contact your sales or service representative.

1. Open the bypass tray.

BLF005S

2. Gently insert paper face down into the bypass tray until the beeper sounds, and then adjust
the paper guides to the paper size.

If the paper size of the paper guide and the paper do not match, skewing and misfeeds might occur.

Do not stack paper over the limit mark, otherwise a skewed image or misfeeds might occur.
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Open out the extender to support paper sizes larger than A4 , 81/2 "  11 " .

Fan the paper to get air between the sheets to avoid a multi-sheet feed.

1

2

BLB002S

1. Paper Guide

2. Extender

3. Set the paper size using the printer driver or the control panel.

• When loading thick paper, thin paper, or OHP transparencies, set paper size and paper type.

• The number of sheets that can be loaded in the bypass tray depends on the paper type.

• When loading letterhead paper, see "Loading Paper", About This Machine.

• Depending on the environment where the machine is being used, you might at times hear a rustling
noise from paper moving through the machine. This noise does not indicate a malfunction.

• When the Panel Key Sound is turned off, it will not sound if you insert paper into the bypass tray. For
details about Panel Key Sound, see "System Settings", Network and System Settings Guide.

• For details about setting printer drivers, see the printer driver Help.

Setting the Paper Size Using the Control Panel

Follow the procedure below to set the machine using the control panel when loading standard size paper
onto the bypass tray.

• The following procedures are not required if you select [Driver/Command] from [Bypass Tray Priority]
in [System] of [Printer Features] (see "Printer Features"). In that case, set the paper size using the printer
driver.

• Under [Printer Features], [System], if you set [Bypass Tray Priority] to [Driver/Command], paper size
settings made on the printer driver must match those made on the control panel. If they do not match,
an error message appears and printing stops if [Printer Features], [System], [Auto Continue] is not set.
For details about [Printer Features] settings, see "Printer Features"
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1. Press the [User Tools/Counter] key on the control panel.

BHM003S

2. Press the [ ] or [ ] key to select [System Settings], and then press the [OK] key.

3. Press the [ ] or [ ] key to select [Tray Paper Settings], and then press the [OK] key.

4. Press the [ ] or [ ] key to select [Printer Bypass Paper Size], and then press the [OK] key.

5. Press the [ ], [ ], [ ], or [ ] key to select the paper size you want to use, and then press
the [OK ] key.

6. Press the [User Tools/Counter] key to return to the initial screen.
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• When loading thick paper, thin paper, or OHP transparencies, set paper size and paper type.

• [Auto Detect] is the default setting for [Printer Bypass Paper Size].

• For details about setting printer drivers, see the printer driver Help.

• p.109 "Printer Features"

Setting Custom Size Paper Using the Control Panel

Follow the procedure below to set the machine using the control panel when loading custom size paper
onto the bypass tray.

• The following procedures are not required if you select [Driver/Command] from [Bypass Tray Priority]
in [System] of [Printer Features] (see "Printer Features"). In that case, set the paper size using the printer
driver.

• If you select [Machine Settings] from [Bypass Tray Priority] in [System] of [Printer Features] (see "Printer
Features"), the settings made using the control panel have priority over the printer driver settings.

• If the printer driver is not used, select [Machine Settings] from [Bypass Tray Priority] in [System] of
[Printer Features] (see "Printer Features"). Set paper size using the control panel.

1. Press the [User Tools/Counter] key on the control panel.

BHM003S

2. Press the [ ] or [ ] key to select [System Settings], and then press the [OK] key.
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3. Press the [ ] or [ ] key to select [Tray Paper Settings], and then press the [OK] key.

4. Press the [ ] or [ ] key to select [Printer Bypass Paper Size], and then press the [OK] key.

5. Press the [ ], [ ], [ ], or [ ] key to select the [Custom Size], and then press the [OK] key.

6. Press the [ ] or [ ] key to enter the horizontal value, and then press the [OK] key.

7. Press the [ ] or [ ] key to enter the vertical value, and then press the [OK] key.
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8. Press the [User Tools/Counter] key to return to the initial screen.

• When loading thick paper, thin paper, or OHP transparencies, set paper size and paper type.

• [Auto Detect] is the default setting for [Printer Bypass Paper Size].

• For details about setting printer drivers, see the printer driver Help.

• p.109 "Printer Features"

Setting Thick Paper, Thin Paper, or OHP Transparencies Using the Control Panel

Follow the procedure below to set the machine using the control panel when loading thick paper, thin
paper, or OHP transparencies onto the bypass tray.

• The following procedures are not required if you select [Driver/Command] from [Bypass Tray Priority]
in [System] of [Printer Features] (see "Printer Features"). In that case, set the paper size using the printer
driver.

• If you select [Machine Settings] from [Bypass Tray Priority] in [System] of [Printer Features] (see "Printer
Features"), the settings made using the control panel have priority over the printer driver settings.

• If the printer driver is not used, select [Machine Settings] from [Bypass Tray Priority] in [System] of
[Printer Features] (see "Printer Features"). Set the paper size using the control panel.

• When printing onto OHP transparencies, paper thinner than 66.0 g/m2, or paper of 101 g/m2 or
above, you need to specify the type and size of paper with Tray Paper Settings in User Tools Menu.
For details about Tray Paper Settings, see "System Settings", Network and System Settings Guide.

• Do not use color OHP transparencies that have easily melted coatings.

• When printing onto OHP transparencies, use A4 , or 81/2" 11" , size sheets, and specify its size.
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• Be sure to remove printed OHP transparencies one by one as they are delivered. This prevents them
sticking together.

1. Press the [User Tools/Counter] key on the control panel.

BHM003S

2. Press the [ ] or [ ] key to select [System Settings], and then press the [OK] key.

3. Press the [ ] or [ ] key to select [Tray Paper Settings], and then press the [OK] key.

4. Press the [ ] or [ ] key to select [Paper Type:Bypass Tray], and then press the [OK] key.

5. Press the [ ] or [ ] key to select the proper items, according to the paper type you want to
set.
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6. Press the [OK] key.

7. Press the [User Tools/Counter] key to return to the initial screen.

• Printing on special paper such as thick paper, thin paper, or OHP transparencies may be slower than
printing on plain paper.

• The settings made will remain valid until they are reset again. After printing on OHP transparencies
or thick paper, thin paper, make sure to clear settings for the next user.

• For details about setting printer drivers, see the printer driver Help.

• p.109 "Printer Features"

Setting Envelopes Using the Control Panel

Follow the procedure below to set the machine using the control panel when loading envelopes onto the
bypass tray.

• The following procedures are not required if you select [Driver/Command] from [Bypass Tray Priority]
in [System] of [Printer Features] (see "Printer Features"). In that case, set the paper size using the printer
driver.

• If you select [Machine Settings] from [Bypass Tray Priority] in [System] of [Printer Features] (see "Printer
Features"), the settings made using the control panel have priority over the printer driver settings.

• If the printer driver is not used, select [Machine Settings] from [Bypass Tray Priority] in [System] of
[Printer Features] (see "Printer Features"). Set paper size using the control panel.

• Misfeeds might also occur when using envelopes (1) - (3) depending on the length and shape of the
flaps.
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Envelope types Supported/Not supported

BAV026S

Supported

BAV027S

Supported

BAV028S

Supported

• You can load up to 10 envelopes (72 - 90g/m2) in the bypass tray at the same time, without
compressing them. Check the envelopes are not damp, and the top of the stack is not higher than the
limit mark on the side guide.

• When loading envelopes, be sure to unfold the flaps and position them opposite to the paper feed
direction.

• Load type (4) (162  114 mm / C6) (6.38  4.49 in. / C6) envelopes flap down, flap fold against
the side guide.

BLD004S

• Depending on the envelope type, specify an appropriate print image rotation using the printer driver.
For a type (1) - (4) envelope, rotate by specify 180 degrees.
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• To print on type (4) (custom paper size) envelopes using the RPCS printer driver: in the printer driver's
[Paper position in tray] area, specify [Place as portrait]. For details, see the printer driver Help.

• Check there is no air in the envelopes before loading.

• To get better print quality, it is recommended that you set the right, left, top, and bottom print margin,
to at least 15 mm (0.6 in.) each.

• You cannot print envelopes with duplex function.

• Load only one size and type of envelope at a time.

• Before loading envelopes, flatten leading edges (the side going into the machine) by pressing a pencil
or ruler across them.

• Before loading envelopes, check they are rectangular in shape.

1. Open the bypass tray, and then insert the envelopes with the side you want to print face-
up until the beeper sounds.

BLD003S

2. Press the [User Tools/Counter] key on the control panel.

BHM003S

3. Press the [ ] or [ ] key to select [System Settings], and then press the [OK] key.
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4. Press the [ ] or [ ] key to select [Tray Paper Settings], and then press the [OK] key.

5. Press the [ ] or [ ] key to select [Printer Bypass Paper Size], and then press the [OK] key.

6. Press the [ ], [ ], [ ], or [ ] key to select the [Custom Size], and then press the [OK] key.

7. Press the [ ] or [ ] key to enter the horizontal value, and then press the [OK] key.

8. Press the [ ] or [ ] key to enter the vertical value, and then press the [OK] key.
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9. Press the [ ] or [ ] key to select [Paper Type:Bypass Tray], and then press the [OK] key.

10. Press the [ ] or [ ] key to select [Envelope], and then press the [OK] key.

11. Press the [User Tools/Counter] key to return to the initial screen.

• When entering the horizontal size for envelopes, including the opened-out flap in the measurement.

BAT029S

1. Vertical size

2. Horizontal size
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• For details about envelopes, see "Envelope", About This Machine.
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1. Preparing the Machine
This chapter describes how to connect this machine to your computer, and install the printer driver.

Confirming the Connection Method
This machine supports network and local connection.

Before installing the printer driver, check how the machine is connected. Follow the driver installation
procedure that is appropriate to the connection method.

Network Connection

This machine can be used as a Windows printing port or network printer.

Using this printer as the Windows printing port

Network connections can be established through Ethernet.

Available ports are determined based on the combination of Windows operating system version and
connection method used.

BMG021S
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Windows 2000/XP, Windows Server 2003/2003 R2

Connection Method Available Ports

• Ethernet • SmartDeviceMonitor for Client port

• Standard TCP/IP port

• LPR port

Windows Vista, Windows Server 2008

Connection Method Available Ports

• Ethernet • SmartDeviceMonitor for Client port

• Standard TCP/IP port

• LPR port

• WSD port

• See the explanation about how to install the printer driver for each type of port.

• For details about SmartDeviceMonitor for Client port, see "Installing the Printer Driver".

• For details about Standard TCP/IP port, see "Installing the Printer Driver".

• For details about LPR port, see "Installing the Printer Driver".

• For details about WSD port, see "Installing the Printer Driver".

• p.30 "Installing the Printer Driver"

Using as a network printer

This machine can be used as the Windows network printer, the NetWare print server, or the NetWare
remote printer.

1. Preparing the Machine
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• In an IPv6 environment, NetWare servers cannot be used.

• IPX/SPX (NetWare) cannot be used under Windows Vista and Windows Server 2008.

• See the explanation about how to install the printer driver for each type of network printer.

• For details about Windows network printer, see "Using as a Windows Network Printer".

• For details about NetWare print server and remote printer, see "Using as a NetWare Print Server/
Remote Printer".

• p.42 "Using as a Windows Network Printer"

• p.44 "Using as a NetWare Print Server/Remote Printer"

Local Connection

Local connections can be established USB connections.

• For details about USB connections, see "Installing the Printer Driver Using USB".

• p.47 "Installing the Printer Driver Using USB"

Confirming the Connection Method
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Installing the Printer Driver
This section explains how to install the printer driver. There are two ways to install the printer driver: using
Quick Install, which installs the settings at once, or installing the appropriate driver according to the port
you want to use.

Downloading the Printer Driver

You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

If your operating system is Windows XP Pro x64, Windows Vista x64, or Windows Server
2003/2003 R2/2008 x64, you must download the printer driver from the supplier's Web site. Select
this machine and the operating system you are using, and then download it.

Quick Install

Users of Windows 2000/XP/Vista, and Windows Server 2003/2003 R2/2008 can install this software
easily using the supplied CD-ROM.

Using Quick Install, the RPCS printer driver, DeskTopBinder - SmartDeviceMonitor for Client are installed
under network environment, and the TCP/IP port will be set.

• To install the printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as an Administrator.

• If you connect using USB, see "Installing the Printer Driver Using USB" and install the printer driver.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

4. Click [Quick Install].

The software license agreement appears in the [License Agreement] dialog box.

5. After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select the machine model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the machine whose IP address is displayed in [Connect
To].

For parallel connection, select the machine whose printer port is displayed in [Connect To].

7. Click [Install].

The printer driver installation starts.

1. Preparing the Machine
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8. Click [Finish].

A message about restarting the computer appears. Restart the computer to complete installation.

9. Click [Exit] in the first dialog box of the installer, and then take out the CD-ROM.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• Select a machine to whose IP address is displayed in [Connect To] to install SmartDeviceMonitor for
Client when using TCP/IP.

• Quick Install is not available unless bidirectional communication between the machine and computer
is enabled via parallel connection. For details about bidirectional communication between the
machine and computer, see "Making Option Settings for the Printer".

• p.47 "Installing the Printer Driver Using USB"

• p.51 "Making Option Settings for the Printer"

Using the SmartDeviceMonitor for Client Port

• To install SmartDeviceMonitor for Client under Windows 2000/XP/Vista, and Windows Server
2003/2003 R2/2008, you must have an account that has Manage Printers permission. Log on as
an Administrator.

• Install SmartDeviceMonitor for Client before installing the printer driver when using the
SmartDeviceMonitor for Client port.

• To use the PCL printer driver, the optional PCL unit must be installed on the machine.

Installing SmartDeviceMonitor for Client

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

4. Click [DeskTopBinder - SmartDeviceMonitor for Client].

5. The message to quit all other applications appears. Quit all applications, and then click [Next
>].
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6. The software license agreement appears in the [License Agreement] dialog box. After
reading through its contents, click [Yes].

7. Click [Full install] or [Custom install].

[Full install] installs all required applications: DeskTopBinder Lite and SmartDeviceMonitor for
Client.

[Custom install] installs selected applications.

8. Follow the instructions on the display and then click [Next >] to proceed to the next step.

9. After the installation is completed, select one of the options to restart the computer either
now or later, and click [Complete].

Restart the computer to complete installation.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

Installing the PCL or RPCS printer driver (TCP/IP)

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

4. Click [RPCS Printer Driver] or [PCL Printer Driver].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the machine model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

10. Click [Port], and then click [Add].

11. Click [SmartDeviceMonitor], and then click [OK].
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12. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

13. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a machine not listed
here, click [Specify Address], and then enter the IP address or host name of the machine.

14. Check that the port of the selected printer is displayed in [Port].

15. Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or symbols can be entered.

16. Select the [Default Printer] check box to configure the printer as default.

17. Click [Continue].

Installation starts.

18. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

• Setting a user code allows a SmartDeviceMonitor for Admin user to display and check statistics about
the number of sheets which each user prints. For details, see SmartDeviceMonitor for Admin Help.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See "Messages Displayed When Installing the Printer Driver", Troubleshooting.

Installing the PCL or RPCS printer driver (IPP)

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

4. Click [RPCS Printer Driver] or [PCL Printer Driver].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].
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8. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

10. Click [Port], and then click [Add].

11. Click [SmartDeviceMonitor], and then click [OK].

12. Click [IPP].

13. In the [Printer URL] box, enter "http://printer's IP address/printer" as the printer's address.

If the server authentication is issued, to enable SSL (a protocol for encrypted communication), enter
"https://printer's IP address/printer" (Internet Explorer 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://printer's IP address/ipp" as the printer's address.

14. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
one of any existing ports.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

15. Click [Detailed Settings] to make necessary settings.

For details about the settings, see SmartDeviceMonitor for Client Help.

16. Click [OK].

17. Check that the port of the selected printer is displayed in [Port].

18. Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or symbols can be entered.

19. Select the [Default Printer] check box to configure the printer as default.

20. Click [Continue].

Installation starts.

21. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.
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• Setting a user code allows a SmartDeviceMonitor for Admin user to display and check the number
of sheets each user prints. For details, see SmartDeviceMonitor for Admin Help.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See "Messages Displayed When Installing the Printer Driver", Troubleshooting.

Changing the port settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client settings, such as TCP/IP timeout,
recovery/parallel printing, and printer groups.

Windows 2000:

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use. On the [File] menu, click [Properties].

3. On the [Ports] tab, click [Configure Port].

The [Configuration] dialog box appears.

Windows XP, Windows Server 2003/2003 R2:

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use. On the [File] menu, click [Properties].

3. Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration] dialog box appears.

Windows Vista, Windows Server 2008:

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer].

The [Printers] window appears.

3. Right-click the icon of the printer you want to use, and then click [Properties].

4. Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration:] dialog box appears.

• For TCP/IP, timeout setting can be configured.

• User, proxy, and timeout settings can be configured for IPP.
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• If no settings on the [Recovery/Parallel Printing] tab are available, follow the procedure below.

1. Click [Cancel] to close the [Port Configuration:] dialog box.

2. Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Client icon
on the task tray.

3. Point to [Properties], and then click [Extended Features Settings].

4. Select the [Set Recovery/Parallel Printing for each port] check box.

5. Click [OK] to close the [Extended Features Settings] dialog box.

• For details about these settings, see "Using SmartDeviceMonitor for Client", or SmartDeviceMonitor
for Client Help.

Using the Standard TCP/IP Port

This describes how to install the PCL, or RPCS printer driver using the TCP/IP port.

• To install this printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as a member of
the Administrators group.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the SmartDeviceMonitor for
Client port.

• To use the PCL printer driver, the optional PCL unit must be installed on the machine.

Installing the PCL or RPCS printer driver

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

4. Click [RPCS Printer Driver] or [PCL Printer Driver].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

1. Preparing the Machine

36

1



9. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

10. Click [Port], and then click [Add].

11. Click [Standard TCP/IP Port], and then click [OK].

Configure the Standard TCP/IP port settings, and then see Windows Help if [Standard TCP/IP Port]
does not appear.

12. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

13. Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

When the device selection appears, select "RICOH NetworkPrinter Driver C Model".

14. Click [Next >].

15. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

The installation start dialog box reappears.

16. Check that the port of the selected printer is displayed in [Port].

17. Configure the default printer as necessary.

18. Click [Continue].

The printer driver installation starts.

19. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See "Messages Displayed When Installing the Printer Driver", Troubleshooting.

Using the LPR Port

This describes how to install the PCL, or RPCS printer driver using the LPR port.
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• To install this printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as a member of
the Administrators group.

• In an IPv6 environment, you cannot use the LPR Port. Use the SmartDeviceMonitor for Client port.

• To use the PCL printer driver, the optional PCL unit must be installed on the machine.

Installing the PCL or RPCS printer driver

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

4. Click [RPCS Printer Driver] or [PCL Printer Driver].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

8. Click [Next >].

9. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

10. Click [Port], and then click [Add].

11. Click [LPR Port], and then click [OK].

If [LPR Port] does not appear, see Windows Help and install it.

12. Enter the printer's IP address in the [Name or address of server providing lpd] box.

13. Enter "lp" in the [Name of printer or print queue on that server] box, and then click [OK].

The port is added.

14. Check that the port of the selected printer is displayed in [Port].

15. Configure the default printer as necessary.

16. Click [Continue].

The printer driver installation starts.
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17. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See "Messages Displayed When Installing the Printer Driver", TroubleShooting.

Using the WSD port

This section explains installation when using the WSD port.

• The WSD port can be used under Windows Vista or Windows Server 2008.

• To install under Windows Vista or Windows Server 2008, you must have an account that has Manage
Printers permission. Log on as an Administrator.

• If the printer is connected using the WSD port, bi-directional communication is not possible. For details
about bi-directional communication, see "Making Option Settings for the Printer".

• You can connect to the printer only if both the printer and computer are on the same network segment,
or "Network discovery" is enabled. For details, see Windows Help.

• To use the PCL printer driver, the optional PCL unit must be installed on the machine.

• p.51 "Making Option Settings for the Printer"

Installing the PCL or RPCS printer driver

1. Quit all applications currently running.

2. On the [Start] menu, click [Network].

The [Network] window appears, and the device search begins automatically.

3. Right-click the printer's icon, and then click [Install].

If the [User Account Control] dialog box appears, click [Continue].

The [Found New Hardware] dialog box appears.
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4. Click [Locate and install driver software (Recommended)].

If the [User Account Control] dialog box appears, click [Continue].

5. Click [Don't search online].

6. Click [Browse my computer for driver software (advanced)].

7. Insert the provided CD-ROM into the computer's CD-ROM drive.

If the [AutoPlay] dialog box appears, click the [close] button and then proceed to step 8.

8. Click [Browse...], and then specify a location for the printer driver.

If the CD-ROM drive letter is D, the printer driver's source files are stored in "D:\DRIVERS\RPCS
\XP_VISTA\(Language)\DISK1".

9. Click [Next].

If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].

10. Click [Close].

If installation is successful, the icon of the printer connected to the "WSD" port is added to the [Printers]
window.

• The port name that follows "WSD" uses random character strings. It cannot be changed freely.

• To stop the installation, click [Cancel] before the installation is complete. When re-installing the WSD
Port, right-click the printer's icon in the [Network] window, and then click [Uninstall].
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Installing the TWAIN Driver
This section explains how to install the TWAIN driver on a client computer from the supplied "Scanner
Driver and Utilities" CD-ROM.

To use the network TWAIN scanner, you must install the TWAIN driver on a client computer.

1. Start Windows, and then insert the CD-ROM labeled "Scanner Driver and Utilities" into the
CD-ROM drive of the client computer.

The installer is automatically started and the [Scanner Driver and Utilities] dialog box appears.

2. Select an interface language, and then click [OK].

3. Click [TWAIN Driver].

4. The installer of the TWAIN driver starts. Follow the instructions.

• Auto-run program may not automatically work with certain operating system settings. If this happens,
start "Setup.exe" on the CD-ROM root directory.

• When the installation is complete, a message about restarting the client computer may appear. In this
case, restart the client computer.

• After the installation is complete, a folder with the name of the machine in use is added in [Programs]
or [All Programs] on the [Start] menu. Help can be displayed from here.

• Notes on using the network TWAIN scanner are provided in "Readme.txt". Be sure to read them before
use.
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Using as a Windows Network Printer
This describes how to install the PCL, or RPCS printer driver when using the printer as a Windows network
printer.

To use the print server, install the printer driver by selecting "Network printer server", and then select the
Windows 2000/XP/Vista, or Windows Server 2003/2003 R2/2008 shared printer.

This section assumes that the client has already been configured to communicate with a Windows 2000/
XP/Vista, or Windows Server 2003/2003 R2/2008 print server. Do not begin the following procedure
before the client is set up and configured correctly.

• To install the printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as a member of
the Administrators group.

• If you print with a print server connected to the printer using the SmartDeviceMonitor port, Recovery
Printing and Parallel Printing cannot be used from the client.

• If you print under Windows XP/Vista or Windows Server 2003/2003 R2/2008 print server,
notification functions of SmartDeviceMonitor may not be used with the client.

• You can install the printer driver from the CD-ROM provided with this printer or download it from the
supplier's Web site.

• If your operating system is Windows XP Pro x64, Windows Vista x64, or Windows Server
2003/2003 R2/2008 x64, you must download the printer driver from the manufacturer's Web site.
Select this printer and the operating system you are using, and then download it.

• To use the PCL printer driver, the optional PCL unit must be installed on the machine.

Installing the PCL or RPCS Printer Driver

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

4. Click [RPCS Printer Driver] or [PCL Printer Driver].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].
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8. Select the [Printer Name] check box to select the printer models you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

10. Click [Port], and then click [Add].

11. Click [Network Printer], and then click [OK].

12. Double-click the computer name you want to use as a print server in the [Browse for Printer]
window.

13. Select the printer you want to use, and then click [OK].

14. Check that the port of the selected printer is displayed in [Port].

15. Configure the user code as necessary.

For an RPCS printer driver, a user code can be set after the printer driver installation.

For details about user code, see the printer driver Help.

16. Select the [Default Printer] check box to configure the printer as default.

17. Click [Continue].

The printer driver installation starts.

18. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run.

• If you still want to install the printer driver, use [Add Printer]. See “Messages Displayed When Installing
the Printer Drive” Troubleshooting.
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Using as a NetWare Print Server/Remote Printer
This describes how to set up the Windows computer used as the NetWare client.

• To install this printer driver under Windows 2000/XP, and Windows Server 2003/2003 R2, you
must have an account that has Manage Printers permission. Log on as a member of the Administrators
group.

• In an IPv6 environment, NetWare servers cannot be used.

• IPX/SPX (NetWare) cannot be used under Windows Vista and Windows Server 2008.

• To use the PCL printer driver, the optional PCL unit must be installed on the machine.

The following explanation assumes NetWare Client is installed on the client computer and the NetWare
server environment is correctly set up. Install all necessary client applications before following this
procedure.

Set up the printer driver while logging on to the NetWare file server.

The following values are used in the example:

• NetWare version: 4.1

• File server name: CAREE

• Queue name: R-QUEUE

1. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

2. Select an interface language, and then click [OK].

3. Click [RPCS Printer Driver] or [PCL Printer Driver].

4. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

5. Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

6. Click [Next >].

7. Select the [Printer Name] check box to select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

8. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.
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9. Click [Port], and then click [Add].

10. Click [Network Printer], and then click [OK].

11. Double-click the name of the NetWare file server on the network tree.

The created queue is displayed.

12. Select the print queue, and then click [OK].

13. Check that the port of the selected printer is displayed in [Port].

14. Click [Continue].

The printer driver installation starts.

15. Click [Finish] in the [Select Program] dialog box.

16. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

17. After restarting the computer, open the printer properties from the [Printers and Faxes]
window.

Under Windows 2000 or Windows Server 2003/2003 R2, launch the [Printers] window, and then
open the printer properties.

18. Click the [NetWare setting] tab.

Under Windows Server 2003/2003 R2, on the [Printer Settings] tab, clear the [Form Feed] and
[Enable Banner] check boxes.

Do not select these check boxes since they are automatically selected by the printer driver. If you
select the check boxes, the printer may not print correctly.

19. Click [OK] to close the printer properties dialog box.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• The protocol is set to inactive as default. Enable it using Web Image Monitor or Telnet.

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the printer driver on Windows. If
NetWare form feed is configured, the printer may not print properly.

Follow the procedure below to disable form feed according to the operating system used:

• Under Windows 2000/XP, or Windows Server 2003/2003 R2, clear the [Form feed] check box
on the [NetWare Settings] tab in the printer properties dialog box.
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Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating system used:

• Under Windows 2000/XP, or Windows Server 2003/2003 R2, clear the [Enable banner] check
box on the [NetWare Settings] tab in the printer properties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the printer is reset. During this
period, jobs may be accepted (depending on NetWare specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server that the remote printer is
disconnected, or wait for two minutes before trying to print.
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Installing the Printer Driver Using USB
This section explains how to install printer drivers using USB.

Before installing, check that only the operating system is running on the computer and no print jobs are in
progress.

You can the printer driver included on the CD-ROM provided with this machine, or can download it from
the supplier’s Web site.

Windows 2000 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the printer is off.

2. Connect the printer and computer using the USB cable.

Connect the USB cable firmly.

3. Turn on the power of the printer.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard window, click [Next >].

5. Click [Search for a suitable driver for my device [recommended]], and then click [Next >].

6. Insert the CD-ROM in the CD-ROM drive.

If Auto Run starts, click [Cancel] and then [Exit].

7. Select the [CD-ROM drivers] check box, and then click [Next >].

8. Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following locations:

• RPCS

D:\DRIVERS\RPCS\XP_VISTA\(Language)\DISK1

• PCL 5c

D:\DRIVERS\PCL5C\XP_VISTA\(Language)\DISK1

• PCL 6
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D:\DRIVERS\PCL6\XP_VISTA\(Language)\DISK1

9. Check the printer driver location, and then click [OK].

10. Click [Next >].

11. Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after "USB" varies depending on the number of printers connected.

Windows XP, Windows Server 2003/2003 R2 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the printer is off.

2. Connect the printer and computer using the USB cable.

Connect the USB cable firmly.

3. Turn on the power of the printer.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard window, click [Install from a list or specific location
[Advanced]], and then click [Next >].

5. Insert the CD-ROM in the CD-ROM drive.

If Auto Run starts, click [Cancel] and then [Exit].

6. Select the [Search removable media (floppy, CD-ROM...)] check box under [Search for the
best driver in these locations], and then click [Next >].

7. Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following locations:

• RPCS

D:\DRIVERS\RPCS\XP_VISTA\(Language)\DISK1
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• PCL 5c

D:\DRIVERS\PCL5C\XP_VISTA\(Language)\DISK1

• PCL 6

D:\DRIVERS\PCL6\XP_VISTA\(Language)\DISK1

8. Check the printer driver location, and then click [OK].

9. Enter the path to the file, and then click [OK].

10. Click [Next >].

11. Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after "USB" varies depending on the number of printers connected.

Windows Vista, Windows Server 2008 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• To use the PCL printer driver, the optional PCL unit must be installed on the machine.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this printer.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the printer is off.

2. Connect the printer and computer using a USB cable.

Connect the USB cable firmly.

3. Turn on the power of the printer.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard display, click [Search for a suitable driver for my device
[recommended]], and then click [Next >].

Installing the Printer Driver Using USB
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5. Insert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

6. Select the [Include this location in the search] check box under [Search for the best driver in
these location], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following locations:

• RPCS

D:\DRIVERS\RPCS\XP_VISTA\(Language)\DISK1

• PCL 5c

D:\DRIVERS\PCL5C\XP_VISTA\(Language)\DISK1

• PCL 6

D:\DRIVERS\PCL6\XP_VISTA\(Language)\DISK1

7. Check the printer driver location, and then click [Next >].

8. Click [Continue].

9. Click [Finish].

If the installation is successful, the icon of the printer connected to the "USB001" port is added to the
[Printers and Faxes] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after "USB" varies depending on the number of printers connected.
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Making Option Settings for the Printer
Make option settings for the printer using the printer driver when bidirectional communication is disabled.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed direction settings to be
automatically sent to the printer. You can check printer status from your computer.

• Bidirectional communication is supported by Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008.

• If you use the RPCS printer driver and bidirectional communication is enabled under Windows 2000,
the [Change Accessories] tab is unavailable.

To support bidirectional communication, the following conditions must be met:

When connected with the network

• The machine must support bidirectional communication.

• The Standard TCP/IP port must be used.

• [Enable bidirectional support] must be selected, and [Enable printer pooling] must not be
selected on the [Ports] tab with the RPCS printer driver.

• In addition to the above, one of the following conditions must also be met:

• The SmartDeviceMonitor for Client port and the TCP/IP protocol must be used. When using
the IPP protocol, the IPP port name must include the IP address.

• [Enable bidirectional support] must be selected, and [Enable printer pooling] must not be
selected on the [Ports] tab with the RPCS printer driver.

When connected with USB

• The printer must be connected to the computer's USB port using the USB interface cable (for
Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008).

• The computer must support bidirectional communication.

• The RPCS printer driver supports bidirectional communication and updates the printer status
automatically.

• The PCL printer driver supports bidirectional communication. You can update the printer status
manually.

• Install SmartDeviceMonitor for Client from the supplied CD-ROM.

Making Option Settings for the Printer
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If Bidirectional Communication Is Disabled

Set up option settings when bidirectional communication is disabled.

• Under Windows 2000/XP/Vista, and Windows Server 2003/2003 R2/2008, Manage Printers
permission is required to change the printer properties in the [Printers] folder. Log on as a member of
the Administrators group.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

When using Windows 2000, point to [Settings] on the [Start] menu, and then click [Printers]. The
[Printers] window appears.

When using Windows Vista, click [Control Panel] on the [start] menu, and then click [Printer]. The
[Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

When using Windows Vista, right-click the icon of the printer you want to use, and then click the
[Properties].

4. Click the [Change Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection is enabled. In this
case, no change is necessary for option settings.

If you are using the RPCS printer driver, click the [Change Accessories] tab.

5. Select options installed from the [Select printer options:] area, and then make the necessary
settings.

6. Select the total amount of the memory in [Total memory:] when the optional SDRAM module
is added.

7. Under [Paper source tray settings:], click the tray to be used, and then select the appropriate
size, position, and type for the tray. Select the [Do not use Auto Tray Select] check box to
exclude the tray from the targets of automatic tray selection.

8. Click [OK] to close the printer properties dialog box.
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Installing Font Manager

• The Font Manager can be used under Windows 2000/XP/Vista.

• Under Windows 2000/XP/Vista, installing applications by Auto Run requires Administrator privilege.
To install a printer driver by Auto Run, log on using an account that has Administrator privilege.

1. Quit all applications currently running.

2. Insert the CD-ROM labeled "Font Manager" into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

4. Click [Font Manager].

5. Follow the instructions on the display.

Installing Font Manager
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2. Setting Up the Printer Driver
This chapter explains the printer properties and how to make changes to the printer settings.

PCL - Accessing the Printer Properties

• To use the PCL printer driver, the optional PCL unit must be installed on the machine.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators group have Manage Printers
permission by default.

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer default settings - printing preferences

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.
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1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following procedure explains how to make printer settings for a specific application using
Windows 2000 Wordpad as an example.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. In the [Select Printer] list, select the printer you want to use.

3. Make the settings you require, and then click [OK].

• Procedures for opening the [Printing Preferences] dialog box vary depending on the application. For
details, see the manuals provided with the application.

• Any settings you make using this procedure apply to the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from the application.

• For details, see the printer driver Help.
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Windows XP, Windows Server 2003/2003 R2 - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators group have Manage Printers
permission by default.

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer default settings - printing preferences

• You cannot change the printer default settings for individual user. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

PCL - Accessing the Printer Properties
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Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following procedure explains making printer settings for Windows XP WordPad as an
example of how to make printer settings for a specific application.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. In the [Select Printer] list, select the printer you want to use.

3. Click [Preferences].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• Procedures for opening the [Printing Preferences] dialog box vary depending on the application. For
details, see the manuals provided with the application.

• Any settings you make using this procedure apply to the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used the defaults when printing from the application.

• For details, see the printer driver Help.

Windows Vista, Windows Server 2008 - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators group have Manage Printers
permission by default.

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. In "Hardware and Sound", click [Printer].

3. Right-click the icon of the printer you want to use, and then click [Properties].

The [Printer Properties] dialog box appears.

2. Setting Up the Printer Driver
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4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer default settings - printing preferences

• You cannot change the printer default settings for individual users. Settings made in the [Printing
Preferences] dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. In "Hardware and Sound", click [Printer].

3. Right-click the icon of the printer you want to use, and then click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following procedure explains how to make printer settings for a specific application using
Windows Vista Wordpad as an example.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. In the [Select Printer] list, select the printer you want to use.

3. Click [Preferences].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• Procedures for opening the [Printing Preferences] dialog box vary depending on the application. For
details, see the manuals provided with the application.

PCL - Accessing the Printer Properties
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• Any settings you make using this procedure apply to the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used the defaults when printing from the application.

• For details, see the printer driver Help.
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60

2



RPCS - Accessing the Printer Properties
There are two dialog box types of the [Printer Properties] dialog box.

"Multi-tab" is used as an example in this manual. For details about changing the dialog box types, see the
printer driver Help.

Multi-tab

This dialog box type is designed for users who often change print settings to perform various printing
operations.

Custom Setting

This dialog box type is designed for users who rarely change print settings. This type of dialog box
may vary depending on the installed options.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators group have Manage Printers
permission by default.

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

When you open the [Printer Properties] dialog box for the first time after installing the RPCS printer
driver, a confirmation message appears. After you click [OK], the [Printer Properties] dialog box
appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

RPCS - Accessing the Printer Properties
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Making printer default settings - printing preferences

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following procedure explains making printer settings for Windows 2000 WordPad as an
example of how to make printer settings for a specific application.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.

3. Make the settings you require, and then click [OK].

• Procedures for opening the [Printing Preferences] dialog box vary depending on the application. For
details, see the manuals provided with the application.

• Any settings you make using this procedure apply to the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used the defaults when printing from the application.

• For details, see the printer driver Help.
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Windows XP, Windows Server 2003/2003 R2 - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators group have Manage Printers
permission by default.

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

When you open the [Printer Properties] dialog box for the first time after installing the RPCS printer
driver, a confirmation message appears. After you click [OK], the [Printer Properties] dialog box
appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer default settings - printing preferences

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

RPCS - Accessing the Printer Properties

63

2



• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following procedure explains making printer settings for Windows XP WordPad as an
example of how to make printer settings for a specific application.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. In the [Select Printer] list, select the printer you want to use.

3. Click [Preferences].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• Procedures for opening the [Printing Preferences] dialog box vary depending on the application. For
details, see the manuals provided with the application.

• Any settings you make using this procedure apply to the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used the defaults when printing from the application.

• For details, see the printer driver Help.

Windows Vista, Windows Server 2008 - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators group have Manage Printers
permission by default.

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.
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1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. In "Hardware and Sound", click [Printer].

3. Right-click the icon of the printer you want to use, and then click [Properties].

The [Printer Properties] dialog box appears.

When you open the [Printer Properties] dialog box for the first time after installing the RPCS printer
driver, a confirmation message appears. After you click [OK], the [Printer Properties] dialog box
appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer default settings - printing preferences

• You cannot change the printer default settings for individual users. Settings made in the [Pinter
Preferences] dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer] in "Hardware and Sound".

3. Right-click the icon of the printer you want to use, and then click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following procedure explains how to make printer settings for a specific application using
Windows Vista Wordpad as an example.

RPCS - Accessing the Printer Properties
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1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. In the [Select Printer] list, select the printer you want to use.

3. Click [Preferences].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• Procedures for opening the [Printing Preferences] dialog box vary depending on the application. For
details, see the manuals provided with the application.

• Any settings you make using this procedure apply to the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used the defaults when printing from the application.

• For details, see the printer driver Help.
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Black and White Printing when [Photograph] or
[DTP] is Selected for [Document type]
If you select [Photograph] or [DTP] for [Document type] in the [Printing Preferences] dialog box, black areas
of text and line art might be detected as color images, depending the application you are using. If this
happens, the document might be printed and counted as a CMYK image.

To print and count the document as a Black and White image, use the following procedure to set the color
to black and white in the printer driver.

1. In the printer driver's [Printing Preferences] dialog box, click the [Print Quality] tab.

2. Select the [User settings] check box.

3. In the list box, select a user setting.

4. Click [Change User Settings...].

5. On the [Image Adjustments] tab, select a document type in the [Load document types:] list.

The following document types are selectable:

[Photograph (Quality)], [Photograph (Speed)], [Photograph (High Speed)], [DTP (Quality)], [DTP
(Speed)], and [DTP (High Speed)].

6. In the [Gray reproduction (Txt/Line Art):] list, select [K (Black)].

The gray reproduction is set to pure black, and the [Load document types:] list becomes blank.

If you select the [Print as bitmap] check box on the [Misc.] tab, the gray reproduction setting is ignored,
and black areas of text and line art are printed and counted as CMYK images.

7. Click [OK].

• Black areas of text and line art that were produced using colors other than black and grey are printed
out and counted as CMYK images even if they appear as black or grey on the screen.

Black and White Printing when [Photograph] or [DTP] is Selected for [Document type]
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Registering Classification Codes
This section explains classification codes.

If you register classification codes, the printer logs the number of prints made under each code.

You can register classification codes to individual users and specified purposes, enabling you to monitor
printer usage by each.

For example, you can manage accounts according to individual clients or account titles.

Classification Code - Based Process (example)

BJF013S

1. Divisions, sections, departments, project teams, users, etc., to be managed.

2. The appropriate classification code for the print job is entered.

For details, see "Specifying the Classification Code for a Print Job".

3. The job is printed.

When printing in an environment where classification codes are required, print jobs that do not have a
classification code cannot be printed.

For details, see "Configuring Classification Codes".

4. Classification codes are collected and managed by an external log collection system.

2. Setting Up the Printer Driver
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Configuring Classification Codes

Use Web Image Monitor to specify whether or not to apply classification code requirement to print jobs.

• If "Required" is selected for the classification code requirement setting in Web Image Monitor, any
print job that without a classification code specified will not be printed.

• The configuration page can be printed at any time.

• The default setting for classification code requirement is "Optional".

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network administrator.

4. Click [Configuration] in the left area, and then click [Logs].

5. Check that [Required] or [Optional] is selected for [Classification Code] in the [Common
Settings for All Logs] column.

6. Click [OK].

7. Click [Logout].

8. Quit Web Image Monitor.

Specifying the Classification Code for a Print Job

When printing in an environment where classification codes are required, a classification code must be
specified for each print job.

• To use the PCL printer driver, the optional PCL unit must be installed on the machine.

For the RPCS printer driver:

1. Open the printer properties dialog box after creating a document in an application.

2. Click the [Print Settings] or [Setup] tab.

3. Select Job type in [Job type:] box.

4. Click [Details...].

If you select [Send to Job Binding] in the [Job type:] box, you cannot enter a classification code.

Registering Classification Codes
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5. Enter the classification code in the [Classification code:] box, and then click [OK].

This code identifies the user. The classification code can contain up to 32 alphanumeric (a-z, A-Z,
0-9, "-") characters.

6. Make any other necessary print settings, and then click [OK].

7. A confirmation message appears. Read it, and then click [OK].

8. Execute the print command.

9. The print job is sent to the printer.

For the PCL printer driver:

1. Open the printer properties dialog box after creating a document in an application.

2. Click the [Valid Access] tab.

3. Enter the classification code in the [Classification Code:] box.

This code identifies the user. The classification code can contain up to 32 alphanumeric (a-z, A-Z,
0-9, "-") characters.

4. Make any other necessary print settings, and then click [OK].

5. A confirmation message appears. Read it, and then click [OK].

6. Execute the print command.

7. The print job is sent to the printer.

• The specified classification code is stored in the printer driver.

• To switch between different classification codes, install the printer driver under different names, and
specify different classification code for each driver.

• For details about how to view the log collected using Classification Code, see the manual for the
external log collection system.

• p.30 "Installing the Printer Driver"

• p.55 "PCL - Accessing the Printer Properties"

• p.61 "RPCS - Accessing the Printer Properties"
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3. Print Functions Available for This
Machine
This chapter explains the various printing functions, including Unauthorized Copy Control, Form Feed, and
Letterhead Printing.

Unauthorized Copy Control
You can embed patterns and text under printed text to prevent unauthorized copying of the document.
Unauthorized Copy Control consists of two functions: [Data security for copying] and [Mask type:].

• This function is designed to discourage copying of confidential documents; it does not prevent
unauthorized use of information.

Opening the Unauthorized Copy Control Window

1. In the RPCS printer driver, open the [Printing Preference] window.

2. Click [Add/Change Custom Settings...].

3. Select the [Unauthorized copy...] check box.

4. Click [Control Settings...].

The [Unauthorized Copy Control] window appears.

• For details, see the printer driver Help.

Using [Data security for copying]

You can embed a print pattern by setting it in the printer driver.
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Setting [Data security for copying] in the printer driver

• Select the [Data security for copying] check box. You can also enter the text in the [Text:] box.

• You cannot select the [Mask type:] check box at the same time.

• To print a document protected by gray overprint, the machine must be set up correctly. Consult
your administrator.

Printing a document using [Data security for copying]

BAB013S

1. The pattern and text you have set is printed.

2. The document is copied or stored in copiers/multifunction machines which the optional Copy
Data Security unit is installed.

3. The document is blanked by gray overprint.

• When printing a document that is set with [Data security for copying], the machine does not require
the optional Copy Data Security unit to be installed. The Copy Data Security unit is required when
copying or storing a document protected by gray overprint.

• Only the RPCS printer driver is supported.

• Printing at 200×200 dpi is not possible.

• You cannot partially embed a pattern and text in a document.

• To make the embedded pattern clear, set the character size at least 50 pt (preferably 70 to 80 pt)
and character angle to between 30 and 40 degrees.

• Use 182×257 mm (71/4 ×101/2 in.) or larger paper.

• Use ordinary or recycled paper of at least 70% whiteness.

• Duplex printing may interfere with this function as a result of text and patterns being visible through
the paper.

3. Print Functions Available for This Machine
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• For details about setting [Data security for copying], see the printer driver Help.

Using [Mask type:]

You can embed patterns and texts in a document by setting in the printer driver to prevent unauthorized
copying.

Setting [Mask type:] in the printer driver

• Select a pattern from [Mask type:], and then enter texts in the [Text:] box.

• You can select overprint color from [Black], [Cyan], or [Magenta] in the [Color:] list.

• You can set only [Text:], but [Mask type:] and [Text:] must be set together.

Printing a document using [Mask type:]

BAC034S

1. The pattern and text you have set is printed palely.

2. The document is copied, scanned, or stored in copiers / multifunction machines.

3. The pattern and text you have set appear clearly.

• Only the RPCS printer driver is supported.

• Printing at 200×200 dpi is not possible.

• You cannot partially embed patterns and texts strings in a document.

Unauthorized Copy Control
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• To make the embedded pattern clear, set the character size at least 50 pt (preferably 70 to 80 pt)
and character angle to between 30 and 40 degrees.

• Due to the effects of the settings, the results of copying, scanning, and saving documents in the
document server may vary depending on the machine model and setting conditions.

• Printing with background patterns and texts may be slower than normal printing.

• For details about setting [Mask type:], see the printer driver Help.

Important Notice

• The supplier does not provide warranty regarding the appearance of print patterns and other copy
protection features. The appearance of the print patterns and the performance of Unauthorized Copy
Control may vary depending on the quality of paper used and the machine model and settings.

• The supplier takes no responsibility for any damages sustained in connection with use of or inability
to make use of Unauthorized Copy Control print patterns.

3. Print Functions Available for This Machine
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Form Feed
This section gives instructions for operating the machine when there is no tray for the selected paper size
or type, or when paper loaded in the machine has run out.

• The tray cannot be changed if the following functions are set:

• Duplex Print to a tray that does not support duplex printing

• If form feed is selected for a tray with the following settings, you can change the tray by canceling
the settings:

• Duplex

• If Auto Continue is selected, form fed paper is printed after a set interval. See "Printer Features".

• p.109 "Printer Features"

Printing from a Selected Tray

If the machine does not have a tray for the selected paper size or paper type, or if the selected paper
loaded in the machine has run out, a caution message appears. If this message appears, do the following
procedure.

1. When the caution message appears, press [FormFeed].

A confirmation message appears.

2. Press [OK].

3. Select the tray for form feed using the [ ] or [ ] key from those that appear on the display,
and then press the [OK] key.

Form Feed
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4. The printer prints using the selected tray.

• If a tray with a smaller paper size is selected, the print job may be cut short, or other problems may
occur.

Canceling a Print Job

Follow the procedure below to cancel a print job if the message prompting form feed appears.

1. Press [JobReset].

2. Press [Current].

The confirmation message appears.

To resume printing jobs, press [Resume].

3. Press [Yes] to cancel the print job.

Press [No] to return to the previous display.

• If the machine is shared by multiple computers, be careful not to accidentally cancel someone else's
print jobs.

• You cannot stop printing data that has already been processed. For this reason, printing may continue
for a few pages after you press [JobReset].

• A print job containing a large volume of data may take considerable time to stop.

3. Print Functions Available for This Machine
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• For details, see "Canceling a Print Job".

• p.78 "Canceling a Print Job"
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Canceling a Print Job
This section gives instruction to stop printing from the computer or the control panel.

Canceling a Print Job Using the Control Panel

1. Press [JobReset].

A confirmation message appears.

2. Press [Current].

To resume printing jobs, press [Resume].

3. Press [Yes] to cancel the print job.

Press [No] to return to the previous display.

Windows - Canceling a Print Job from the computer

You can cancel a print job from the computer if transferring print jobs is not completed.

1. Double-click the printer icon on the Windows task tray.

A window appears, showing all print jobs currently queued for printing. Check the current status of
the job you want to cancel.

2. Select the name of the job you want to cancel.

3. On the [Document] menu, click [Cancel].

4. Press the [Printer] key on the machine's control panel.

• If the machine is shared by multiple computers, be careful not to accidentally cancel someone else's
print jobs.

3. Print Functions Available for This Machine
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• Under Windows XP/Vista, or Windows Server 2003/2003 R2/2008, click [Cancel] on the
[Document] menu.

• Under Windows 2000, you can also open the print job queue window by double-clicking the machine
icon in the [Printers] machine window.

• You cannot stop printing data that has already been processed. For this reason, printing may continue
for a few pages after you press [Job Reset].

• A print job containing a large volume of data may take considerable time to stop.

Canceling a Print Job
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Checking the Error Log
If files could not be stored due to printing errors, identify the cause of the errors by checking the error log
on the control panel.

• The most recent 30 errors are stored in the error log. If a new error is added when there are 30 errors
already stored, the oldest error is deleted. You can check any of these print jobs for error log
information.

• If the main power switch is turned off, the error log is deleted.

1. Press [Menu].

2. Press the [ ] or [ ] key to select [Error Log], and then press the [OK] key.

3. Press the [ ] or [ ] key to select the error log you want to check.

• Press the [Escape] key until the initial screen appears after checking the log.

• To print files that appear in the error log, resend them after stored files have been printed or deleted.

3. Print Functions Available for This Machine
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User Defined Pages
Using this function, you can specify the page numbers for each input tray.

• This function is available with the PCL 5c printer driver only.

• To use the PCL printer driver, the optional PCL unit must be installed on the machine.

• If [User Defined Pages] is selected under [Paper Selection:] on the [Paper] tab, [Layout:] cannot be
selected.

BAC028S

• For details, see the printer driver Help.

User Defined Pages
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Printing on Orientation-Fixed or Two-Sided
Paper
This section explains how to print on paper whose orientation and printing side are unchangeable
(letterhead paper, for example).

Use the settings and paper orientations shown below to ensure the machine prints onto orientation-fixed
paper (such as letterhead or continuous stationery) correctly. Specify [Auto Detect] or [On (Always)] for
[Letterhead Setting] in the printer settings, and then place the original and paper as shown below. For
details about the letterhead print settings, see "System".

Paper Orientation

Paper Trays 1-4 Multi Bypass tray

Letterhead Setting

[On(Always)]

Letterhead Setting

[Off]

Letterhead Setting

[On(Always)]

Letterhead Setting

[Off]

1-sided print

2-sided print

1-sided print

2-sided print

• You cannot perform 2-sided (duplex) printing on paper fed from the multi bypass tray.

• To print on letterhead paper when [Letterhead Setting] is set to [Auto], you must specify [Letterhead]
as the paper type in the RPCS printer driver's settings.

3. Print Functions Available for This Machine
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• If you change from 1-sided to 2-sided (duplex) printing during a copy job, all pages printed after the
change will be 2-sided. If you want to print the remaining sets as 1-sided, specify a paper tray that
is not available for duplex printing.

• For details about how to make 2-sided prints, see the printer driver Help.

• p.115 "System"

Printing on Orientation-Fixed or Two-Sided Paper
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4. Direct Printing from a Digital Camera
(PictBridge)
This chapter explains how to print directly from a digital camera.

What is PictBridge?
You can connect a PictBridge-compatible digital camera to this machine using a USB cable. This allows
you to print photographs taken using the digital camera directly by operating the digital camera.

• To use this function, the optional Camera Direct Print Card must be installed on the machine.

BMH004S

• Check your digital camera is PictBridge-compatible.

• Up to 999 images can be sent from the digital camera to the machine during one print transaction.
If an attempt is made to send more images, an error message is sent to the camera and printing fails.

• Since printing conditions are specified on the digital camera, specifiable parameters depend on the
particular digital camera. For details, see your digital camera's manual.

• This function is compatible with USB 2.0.
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PictBridge Printing
Follow the procedure below to start PictBridge printing on this machine.

• Do not disconnect the USB cable while data is being sent. If you do, printing will fail.

• Use the USB cable bundled to your digital camera.

1. Check the machine and the digital camera are both switched on.

2. Connect a USB cable between the USB host interface on the machine and the digital camera.

The Data In indicator on the machine blinks for several seconds and "PctBrdg" is displayed on the
machine's control panel. This indicates the machine recognizes the digital camera as a PictBridge
device.

BMH006S

3. On your digital camera, select the images you want to print, and specify the printing
conditions.

The machine receives settings from the digital camera and starts printing.

• Since printing conditions are specified on the digital camera, specifiable meters depend on the
particular digital camera. For details, see your digital camera's manual.

• Some digital cameras require settings for manual PictBridge operation. For details, see your digital
camera's manual.

4. Direct Printing from a Digital Camera (PictBridge)
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What Can be Done on This Machine
This machine can perform the following functions using its PictBridge feature.

The settings available for these functions are as follows:

• Single image printing

• Selected image printing

• All image printing

• Index printing

• Trimming

• Date and file name printing

• Paper size

• Image print size

• Multi-Image-Layout

• Duplex printing

• Printing quality

• Color matching

• Paper type specification

• Form printing

• Toner saving

• Camera memo printing

• This machine does not support the following settings:

• DPOF printing

• Margin-less printing

• The setting parameters and their names may vary depending on the digital camera. For details, see
your digital camera's manual.

Index Printing

A3 (297  420 mm)

Horizontal images  vertical images (in) Paper orientation

12  16

What Can be Done on This Machine
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Horizontal images  vertical images (in) Paper orientation

16  12

A4 (210  297 mm)

Horizontal images  vertical images (in) Paper orientation

8  12

12  8

A5 (148  210 mm)

Horizontal images  vertical images (in) Paper orientation

5  8

8  5

Letter (81/2 "  11 ")

Horizontal images  vertical images (in) Paper orientation

8  10

10  8

B4 (257  367 mm)

Horizontal images  vertical images (in) Paper orientation

10  14

14  10

• Index printouts vary depending on the orientation of the paper placed on the specified size tray.

• Depending on the digital camera, a form feed may be inserted after one set of images belonging to
one type ends.

• The number of images in each size of paper is fixed.

4. Direct Printing from a Digital Camera (PictBridge)
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Trimming

Use this function to print only inside of the trimming area specified on the digital camera.

BAC031S

*1  Trimming area

Date and File Name Printing

Use this function to print the date and/or file name under the image.

BFL902S

In the above figure, "aaaaa" indicates the file name and "bbbbb" indicates the date.

Paper Size

Use this function to print on paper with the size specified on the digital camera.

Paper size name Actual size

2L (5 "  7 ") 178 mm  127 mm

Postcard 148 mm  100 mm

What Can be Done on This Machine
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Paper size name Actual size

100 mm  150 mm 150 mm  100 mm

4 "  6 " 152.4 mm  101.6 mm

8 "  10 " 254 mm  203.2 mm

Letter (81/2 "  11 ") 279.4 mm  216 mm

11 "  17 " 431.8 mm  279.4 mm

A3 420 mm  297 mm

A4 297 mm  210 mm

A5 210 mm  148 mm

A6 148 mm  105 mm

B4 364 mm  257 mm

B5 257 mm  182 mm

B6 182 mm  128 mm

• Specify Undefined Size for the 2L (5 "  7 "), 100 mm  150 mm, 4 "  6 ", 8 "  10 ", A6, B5, and
B6 sizes.

Image Print Size

Use this function to print images with the size specified on the digital camera.

BFL903S

--indicates the image size specified on the camera.

You can specify the following image print sizes:

Fixed size

• 3.25 "  2.5 "
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• 5 "  3.5 "

• 6 "  4 "

• 7 "  5 "

• 10 "  8 "

• 254 mm  178 mm

• 110 mm  74 mm

• 89 mm  55 mm

• 148 mm  100 mm

• 8 cm  6 cm

• 10 cm  7 cm

• 13 cm  9 cm

• 15 cm  10 cm

• 18 cm  13 cm

• 21 cm  15 cm

• 24 cm  18 cm

• An error occurs if the specified size is larger than the actual paper size.

Multi-Image-Layout

Use this function to print multiple images on the specified paper.

BFL904S

The number of images that can be printed on one page are as follows:

Paper size Number of images that can be specified

2L (5 "  7 ") 2, 4, 8, 9

Postcard 2, 4

What Can be Done on This Machine
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Paper size Number of images that can be specified

100 mm  150 mm 2, 4

4 "  6 " 2, 4, 8, 9

8 "  10 " 2, 4, 8, 9, 16, 25, 32

Letter (81/2 "  11 ") 2, 4, 8, 9, 16, 25, 32

11 "  17 " 2, 4, 8, 9, 16, 25, 32, 49, 64

A3 2, 4, 8, 9, 16, 25, 32, 49, 64

A4 2, 4, 8, 9, 16, 25, 32

A5 2, 4, 8, 9, 16

A6 2, 4, 8

B4 2, 4, 8, 9, 16, 25, 32, 36, 49

B5 2, 4, 8, 9, 16, 25

B6 2, 4, 8, 9

The number and arrangement of images that can be specified are as follows:

Number of images
Vertical images  horizontal

images
Paper orientation

2 2  1

4 2  2

8 4  2

9 3  3

16 4  4

25 5  5

32 8  4

36 6  6

49 7  7
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Number of images
Vertical images  horizontal

images
Paper orientation

64 8  8

• A form feed may be inserted between images depending on the digital camera in use.

• Printing in the specified way may not be possible depending on the specification for the number of
images to be printed.

Duplex Printing

Use this function to enable duplex (double-sided) printing.

Duplex printing is disabled by default. When duplex printing is enabled, the printed pages open to the left.
You cannot change the opening direction to the right.

• Duplex printing might not be possible, depending on the paper type or the tray that the paper is being
fed from.

Printing Quality

Use this function to print images at the selected printing quality.

If you select [Default] or [Normal], the machine prints at 600 dpi  600 dpi (1 bit); if you select [Fine], the
machine prints at 600 dpi  600 dpi (2 bit).

Color Matching

Use this function to optimize colors when printing images.

If you select [Default] or [OFF], the machine prioritizes gradation for color matching, if you select [ON],
the machine prioritizes saturation.

Paper Type Specification

This function sends the machine's paper type information to the digital camera. The names of paper types
displayed on the digital camera's screen are different to the names displayed on the machine. Use the table
below to match the paper types.

What Can be Done on This Machine
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To display a paper type name on the digital camera's screen, use the machine's control panel to set the
paper type of the machine correctly.

Paper type detected by the digital camera Paper type of the machine

Default All Paper types

Plain Paper Plain or recycled paper

Photo Paper HG plain paper or inkjet postcard

Fast Photo Paper Glazed paper

Form Printing

Use this function to print images in a predetermined layout format.

BFL905S

Toner Saving

By specifying the print density on the digital camera, you can save on toner when printing.

Specification on the digital camera Print density

Default/OFF 100%

Slightly light 75%

Light 50%

Camera Memo Printing

Use this function to print text data together with an image if it is attached to the image.

4. Direct Printing from a Digital Camera (PictBridge)

94

4



Exiting PictBridge
Follow the procedure below to quit the PictBridge mode.

• Do not disconnect the USB cable while data is being sent to the machine. If you do, printing will fail.

1. Check the control panel of this machine is displaying the "Ready" state.

2. Disconnect the USB cable from the machine.

Exiting PictBridge
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When PictBridge Printing Does Not Work
This section explains likely causes and possible solutions for problems that can occur when PictBridge
printing.

Problem Cause Solution

PictBridge is not available. There is a problem with the USB
connection or the PictBridge
settings.

Use the following procedure to
check the connection and
settings:

1. Disconnect and then
reconnect the USB cable.

2. Check the PictBridge
settings are enabled.

3. Disconnect the USB cable,
and then turn off the printer.
Turn the printer back on.
When the printer has fully
booted up, reconnect the
USB cable.

When two or more digital
cameras are connected, the
second and subsequent cameras
are not recognized.

You have connected multiple
digital cameras.

Connect one digital camera only.

Do not connect multiple cameras.

Printing is disabled. The number of originals exceeds
the maximum number of pages
that can be printed at a time.

The maximum specifiable print
quantity at a time is 999.
Respecify the quantity to 999 or
less, and then retry printing.

Printing is disabled. There is no paper of the specified
size remaining.

There is no paper of the specified
size remaining.

If you have to use paper that is
not of the specified size, perform
Form Feed. To cancel printing,
perform Job Cancel.

Printing is disabled. The paper size setting for this tray
cannot be printed on the printer.

Select the paper size setting that
can be printed on the printer.

4. Direct Printing from a Digital Camera (PictBridge)
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Other Reference Information
For further details about paper size, paper type and tray settings, see About This Machine.

• For details about paper size, paper type, or tray settings, see About This Machine.

Other Reference Information
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5. Scanning Originals with the Network
TWAIN Scanner
This chapter explains how to use the Network TWAIN scanner.

Before Using the Network TWAIN Scanner
This section describes the preparations and procedure for using the network TWAIN scanner.

The TWAIN driver allows you to scan originals on the machine from a client computer via the network.

• To use the network TWAIN scanner, you must install the TWAIN driver, which is on the supplied CD-
ROM. For details about installing the TWAIN driver, see "Installing the TWAIN Driver".

• To use the network TWAIN scanner, a TWAIN-compliant application, such as DeskTopBinder, must
be installed on the client computer. DeskTopBinder Lite is on the supplied CD-ROM. For details about
installing DeskTopBinder Lite, see "Installing a TWAIN-compliant application on the same client
computer".

• p.41 "Installing the TWAIN Driver"

• p.103 "Installing a TWAIN-compliant application on the same client computer"

Overview of the Network TWAIN Scanner

This section describes the network TWAIN scanner function.

In the TWAIN scanner mode, you can share this machine among multiple computers. Therefore, you don't
have to prepare a special computer for scanner or reconnect the scanner and each computer every time
you need to use it.

ZZZ805S
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1. This Machine

Scans an original after receiving a scan instruction from a client computer, and then sends the scan file over the
network to the client computer.

2. Client Computer

Specifies the scanner settings and controls the scanner using an application, such as DeskTopBinder Lite, that
supports the network TWAIN scanner. Receives the files scanned by the machine and displays them using an
application that supports the network TWAIN scanner.

• When using the machine as a network TWAIN scanner, you do not need to press the [Scanner] key on the
machine's control panel. The screen switches automatically when you scan an original from a client
computer using the TWAIN driver.

Preparing to Use the Network TWAIN Scanner

To use this machine as a network TWAIN scanner, you must first perform the following:

• Check the machine is properly connected to the network

• Configure the network settings in [System Settings]

• Install the TWAIN driver on a client computer

• Install a TWAIN-compliant application on the same client computer

Checking the machine is properly connected to the network

Check that this machine is properly connected to the network.

For details about how to connect this machine to a network, see "Connecting to the Interfaces", Network
and System Settings Guide.

Configuring the network settings in [System Settings]

Configure the network settings in [System Settings] according to your environment and how you will be
using the machine.

The following procedure explains connecting this machine to an IPv4 network using Ethernet cable.

5. Scanning Originals with the Network TWAIN Scanner
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Note that the settings you must configure will vary depending on your operating environment. For details
about network settings and configuration procedures, see "Network Settings Required to Use Network
TWAIN Scanner", Network and System Settings Guide.

1. Press the [User Tools/Counter] key on the control panel.

BHM003S

2. Press the [ ] or [ ] key to select [System Settings], and then press the [OK] key.

3. Press the [ ] or [ ] key to select [Interface Settings], and then press the [OK] key.

4. Press the [ ] or [ ] to select [Network], and then press the [OK] key.

5. Press the [ ] or [ ] key to select [Machine IPv4 Address], and then press the [OK] key.

Before Using the Network TWAIN Scanner
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Enter the IPv4 address and subnet mask. To specify a static IPv4 address for this machine, select
[Specify], and then press [IP Add.]. To specify a subnet mask, select [Specify], and then press [Subnet
M].

To obtain an IPv4 address from a DHCP server automatically for this machine, select [Auto-Obtain
(DHCP)], and then press the [OK] key.

6. Press the [ ] or [ ] key to select [IPv4 Gateway Address], and then press the [OK] key.

7. Press the number keys to enter the gateway address, and then press the [OK] key.

8. Press the [ ] or [ ] key to select [Effective Protocol], and then press the [OK] key.

9. Press the [ ] or [ ] key to select [IPv4], and then press the [OK] key.

10. Press the [ ] or [ ] key to select [Active], and then press the [OK] key.

11. Press the [User Tools/Counter] key to return to the initial screen.

Installing the TWAIN driver on a client computer

Install the TWAIN driver on your computer.

For details about installing the TWAIN driver, see "Installing the TWAIN Driver".

• p.41 "Installing the TWAIN Driver"
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Installing a TWAIN-compliant application on the same client computer

To use this machine as a network TWAIN scanner, a TWAIN-compliant application, such as
DeskTopBinder, must be installed on the client computer. This section explains how to install DeskTopBinder
Lite on a client computer from the supplied "Scanner Driver and Utilities" CD-ROM.

1. Make sure Windows is running on the client computer, and then insert the "Scanner Driver
and Utilities" CD-ROM into the CD-ROM drive.

The installer is automatically started and the [Scanner Driver and Utilities] dialog box appears.

2. Click [DeskTopBinder Lite].

The [DeskTopBinder Lite Setup] dialog box appears.

For the subsequent installation steps, see the Setup Guide displayed from the [DeskTopBinder Lite
Setup] dialog box.

Before Using the Network TWAIN Scanner
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Basic Network TWAIN Scanner Procedure
This section explains the basic procedure for scanning with the network TWAIN scanner.

• To use the network TWAIN scanner, a TWAIN-compliant application, such as DeskTopBinder and
the TWAIN driver must be installed on the client computer.

• Under the Windows XP SP2/Vista or Windows Server 2003/2003 R2/2008 operating system,
when the Windows firewall is enabled, "Cannot find the scanner." or "No response from the scanner."
may appear and scanning with the TWAIN scanner may fail. In this case, change the settings of the
Windows firewall. For details, see Windows Help.

The following procedure uses Windows XP and DeskTopBinder Lite by way of example.

1. On the [Start] menu, point to [All Programs], point to DeskTopBinder, and then click
DeskTopBinder.

2. On the [Tools] menu, click [Scanner Settings...].

3. Click [Select Scanner Driver...].

4. Select the name of the machine you want to use in the list, and then click [Select].

5. Click [OK].

6. Place originals.

7. On the [File] menu, point to [Add Document], and then click [Scan...] to display the Scanner
Control dialog box.

The Scanner Control dialog box and DeskTopBinder viewer will appear.

A dialog box that is used to control a scanner using the TWAIN driver is referred to as the Scanner
Control dialog box.

8. Make settings according to such factors as the type of original, type of scanning, and
orientation of the original.

For details, see the TWAIN driver Help.

9. In the Scanner Control dialog box, click [Scan].

Depending on the security setting, if you press [Scan], a dialog box for entering the user name and
password may appear.

If there are more originals to be scanned, place the next original, and then click [Continue].

If there are no more originals to be scanned, click [Complete].

10. On the [File] menu of the DeskTopBinder viewer, click [Exit].

11. Enter the file name, and then click [OK].

The DeskTopBinder viewer closes and the image is stored in DeskTopBinder Lite.
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104

5



• If you have already selected a scanner, you do not need to select the scanner unless you want
to change it.

• Using DeskTopBinder, you can edit and print scan files. For more information about
DeskTopBinder, see DeskTopBinder manuals.

• The model name of the connected scanner appears in the title bar of the Scanner Control dialog
box. If there is more than one scanner of the same model on the network, make sure you have
selected the correct scanner. If you have not, click [Select Scanner Driver...], and then select the
scanner again. If the correct scanner does not appear in the list, check that the scanner is correctly
connected to the network and that its IPv4 address has been specified. If the correct scanner still
does not appear, consult the network administrator.

Basic Network TWAIN Scanner Procedure
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Scan Settings When Using TWAIN Scanner
This section explains how to specify original orientation and scan setting for a bundle of mixed size originals
when using the TWAIN scanner.

Setting Original Orientation on the TWAIN Scanner

To correctly display the top/bottom orientation of the scanned original on a client computer, the placement
of the original and the settings made in the Scanner Control dialog box must match.

1. Open the Scanner Control dialog box.

For details about how to open the Scanner Control dialog box, see "Basic Network TWAIN Scanner
Procedure".

2. In the [Original Scan Method:] list, select the place where the original is placed.

3. In the [Orig.Orientn.:] list, select [ ] or [ ].

4. In the [Orientation:] list, select [ / ], [ / ],
[ / ], or [ / ].

5. If an original is placed in the ADF, from the drop down menu of [Scan Settings:], select [1
Sided], [2 Sided(Top to Top)], or [2 Sided(Top to Bottom)].

• p.104 "Basic Network TWAIN Scanner Procedure"

Placing Originals

The following table shows the relationship between the original orientation and the Scanner Properties
dialog box settings:

Exposure Glass

Original Orientation TWAIN Scanner Control Dialog Box Key

top edge touches top left of exposure glass

This orientation is the TWAIN driver's
standard setting. Place originals in this
orientation normally.

top edge touches rear of exposure glass

5. Scanning Originals with the Network TWAIN Scanner
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Original Orientation TWAIN Scanner Control Dialog Box Key

bottom edge touches left side of exposure
glass

bottom edge touches top of exposure glass

ADF

Original Orientation TWAIN Scanner Control Dialog Box Key

top edge of original placed first

top edge touches rear of ADF

bottom edge touches left side of ADF

bottom edge touches top of ADF

• Originals are normally rectangular ( ) or horizontally long ( ). However, the table above
uses squares to make original orientation easier to understand. Even if the actual shape of the
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original is different, the combination of original orientation and the orientation specified on the
scanner driver does not change.

• For details about the Scanner Control dialog box, see the TWAIN driver Help.

• Depending on the settings, originals of different sizes are scanned differently.

When Scanning Originals of Mixed Sizes Using TWAIN Scanner

This section explains the differences between scanning mixed-size originals using the TWAIN scanner and
normal scanning.

• If [Auto detect(Mixed-size)] is selected in the [Original Size:] list, the machine detects the length of
each original and then scans them.

• If [Auto detect(Uni-size)] is selected in the [Original Size:] list, the machine detects the size of the first
original of the batch and scans all subsequent originals at that size.

• The paper guides cannot be adjusted to small size originals, which may cause slightly tilted scanning.

5. Scanning Originals with the Network TWAIN Scanner
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6. Printer Features
This chapter describes user tools in the Printer Features menu. For details on how to access Printer Features,
see "Accessing User Tools".

Accessing User Tools
This section describes how to access User Tools menu.

User Tools allow you to change or set defaults.

• Operations for system settings differ from normal operations. Always quit User Tools when you have
finished.

• Any changes you make with User Tools remain in effect even if the main power switch or operation
switch is turned off, or the [Energy Saver] or [Clear Modes] key is pressed.

Changing Default Settings

This section describes how to change the settings of User Tools.

• If Administrator Authentication Management is specified, contact your administrator.

1. Press the [User Tools/Counter] key.

BHM003S

2. Press the [ ] or [ ] key to select [Printer Features], and then press the [OK] key.

3. Change settings by following instructions on the display, and then press [OK] key.

Quitting User Tools

This section describes how to quit the settings of User Tools.
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1. Press the [User Tools/Counter] key.

BHM003S

• You can also quit User Tools by pressing [Exit].

Menu Protect

Using Menu Protect, you can prevent unauthenticated users from changing the user tools. Menu Protect
can be specified for each of the following user tools menus.

• Copier Features

• Facsimile Features

• Printer Features

For details, consult your administrator.
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List/Test Print
This section describes the user tools in the Test Print menu under Printer Features.

Multiple Lists

You can print the configuration page and error log.

Config. Page

You can print the machine's current configuration values.

Error Log

You can print error logs listing all errors that occurred during printing. The most recent 30 errors are
stored in the error log. If a new error is added when there are 30 errors already stored, the oldest
error is deleted. However, if the oldest error belongs to one of the following types of print jobs, it is
not deleted. Instead, it will be stored separately in error logs for each job type, up to a maximum of
30 for each log. You can check any of these print jobs for error log information.

The records of Auto Job Cancel and jobs canceled manually from the control panel can be printed.

Menu List

You can print a Menu List showing the machine's function menus.

PCL Config./Font Page

You can print the current configuration and installed PCL font list.

Hex Dump

You can print in the Hex Dump mode.

Printing the Configuration Page

This section describes how to print the Configuration Page.

1. Press the [User Tools/Counter] key.

2. Press the [ ] or [ ] key to select [Printer Features], and then press the [OK] key.

3. Press the [ ] or [ ] key to select [List/Test Print], and then press the [OK] key.

4. Press the [ ] or [ ] key to select [Config. Page], and then press the [OK] key.

The configuration page is printed.

5. Press the [User Tools/Counter] key.

Interpreting the configuration page

This section describes the Configuration Page.

List/Test Print
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System Reference

• Unit Number

Displays the serial number assigned to the board by its manufacturer.

• Total Counter

Shows the total number of pages printed by the printer to date.

• Firmware Version

• Printer

Displays the version number of the printer firmware.

• System

Displays the version number of the system firmware.

• Engine

Displays the version number of the printer engine.

• NIB

Displays the version number of the Network interface.

• Device Connection

This item(s) appears when the device option(s) is installed.

• Printer Language

Displays the version number of the printer driver language.

• Attached Equipment

Displays the installed optional equipments.

• Consumption Status

Displays the status of consumable.

Paper Input

Displays settings made under Tray Paper Settings menu.

Maintenance

Displays settings made under the Maintenance menu.

System

Displays settings made under the System menu.

PCL Menu

Displays settings made under PCL Menu.

Host Interface

Displays settings made under the Host Interface menu.

6. Printer Features
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When DHCP is active on the network, the actual IPv4 address, subnet mask and gateway address
appear in parentheses on the configuration page.

Interface Information

Displays the interface information.

• p.109 "Accessing User Tools"
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Maintenance
This section describes the user tools in the Maintenance menu under Printer Features.

Menu Protect

You can select where or not to protect menu. When you enable this setting, specify protection level.

The default setting is Level 2.

List/Test Print Lock

You can lock the [List/Test Print] menu.

The default setting is [Off].

4 Color Graphic Mode (4 Colour Graphic Mode)

• Text Priority

Use the optimum CMYK toner combination for text printing.

• Photo Priority

Use the optimum CMYK toner combination for photo printing.

The default setting is [Photo Priority].

• p.109 "Accessing User Tools"
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System
This section describes the user tools in the System menu under Printer Features.

Print Error Report

Select this to have an error report printed when a printer or memory error occurs.

The default setting is [Off].

Auto Continue

You can select this to enable Auto Continue. When it is On, printing continues after a system error
occurs.

The default setting is [Off].

Memory Overflow

Select this to have a memory overflow error report printed.

The default setting is [Do not print].

Rotate by 180 Degrees

Specify whether to rotate the print image 180 degrees relative to the paper orientation.

The default setting is [Off].

Duplex

You can select to have print on both sides of each page.

The default setting is [Off].

Copies

You can specify the number of print sets. This setting is disabled if the number of pages to print has
been specified with the printer driver or another command.

The number of copies can be specified from 1 to 999 by increments of one.

The default setting is “1” copies.

Blank Page Print

You can select whether or not to print blank pages.

The default setting is [On].

Pages that match one of the following conditions are identified as blank.

• There are no images.

• There are images but they are outside the printable area.

• There are only blank characters.

Sub Paper Size

You can enable the Auto Substitute Paper Size (A4, LT) feature.

The default setting is [Auto].

System
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Page Size

You can select the default paper size.

• The paper size you can select is as follows:

A3, A4, A5, A6, B4 JIS, B5 JIS, B6 JIS, C5 Env, C6 Env, DL Env, 12 18, 11 17, 81/2 14, 81/2
13, 81/2 11, 81/4 13, 8 13, 71/4 101/2, 51/2 81/2, 41/8 9 1/2, 3 7/8 71/2, 8K, 16K,

Custom Size

The default setting is A4.

The default setting is 81/2 11.

Letterhead Setting

You can rotate original images when printing.

When printing, original images are always rotated by 180 degrees. Therefore, output might not be
as expected when printing onto letterhead or preprinted paper requiring orientation. Using this
function, you can specify image rotation.

The default setting is [Off].

• Off

When set to [Off], original images are rotated by 180 degrees.

• Auto Detect

When set to [Auto Detect], the machine detects a letterhead or preprinted paper automatically,
and does not rotate the image.

• On (Always)

When set to [On (Always)], the machine does not rotate.

This function reduces printing speed.

Bypass Tray Priority

Specify whether (Printer) Driver/Command or Machine Settings, has priority for determining the
paper size for the bypass tray.

The default setting is [Driver/Command].

Edge to Edge Print

You can select whether or not to print on the entire sheet.

The default setting is [Off].

Tray Switching

You can specify whether or not the machine automatically switches paper trays if paper of the specified
size and type is not loaded in the driver-designated tray.

The default setting is [Off].
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Extend Auto Tray Switching

This setting enables the machine to switch paper trays automatically, regardless of whether the tray
is manually or automatically selected.

When set to [On], [Auto Tray Switching] is enabled and the [Auto Tray Switching] setting configured
in the printer driver is overridden.

The default setting is [Off].

• p.109 "Accessing User Tools"
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Host Interface
This section describes the user tools in the Host Interface menu under Printer Features.

I/O Buffer

You can set the size of the I/O Buffer. Normally it is not necessary to change this setting.

The default setting is [128 KB].

I/O Timeout

You can set how many seconds the machine should wait before ending a print job. If data from another
port usually arrives in the middle of a print job, you should increase this timeout period.

The default setting is [15 seconds].

• p.109 "Accessing User Tools"
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PCL Menu
This section describes the user tools in the PCL Menu under Printer Features.

Orientation

You can set the page orientation.

The default setting is [Portrait].

Form Lines

You can set the number of lines per page.

The number of lines can be specified from 5 to 128 by increments of one.

The default setting is “64” lines.

The default setting is “60” lines.

Font Source

You can set the storage location of the default font.

The default setting is [Resident].

RAM and SD can be selected only when fonts have been downloaded to the machine.

Font Number

You can set the ID of the default font you want to use.

• When [Resident] is selected under "Font Source":

The font number can be specified from 0 to 63 by increments of one.

The default setting is “0”.

• When [RAM] or [SD] is selected under "Font Source":

The font number can be specified from 1 up to number of fonts stored on the machine.

The default setting is “1”.

Point Size

You can set the point size you want to use for the selected font.

The number of point sizes can be specified from 4.00 to 999.75 by increments of 0.25.

This setting is effective only with variable-space fonts.

The default setting is “12.00” points.

Font Pitch

You can set the number of characters per inch for the selected font.

The number of characters per inch can be specified from 0.44 to 99.99 by increments of 0.01.

PCL Menu
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This setting is effective only with fixed-space fonts.

The default setting is “10.00” pitches.

Symbol Set

Specify the character set of the selected font. The available options are as follows:

• Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-852, PC8-TK, Win L1, Win
L2, Win L5, Desktop, PS Text, VN Intl, VN US, MS Publ, Math-8, PS Math, VN Math, Pifont,
Legal, ISO 4, ISO 6, ISO 11, ISO 15, ISO 17, ISO 21, ISO 60, ISO 69, Win 3.0

The default setting is [PC-8].

Courier Font

You can select a courier font type.

The default setting is [Regular].

Ext. A4 Width

You can extend the printing area width (when printing on A4 sheet with PCL).

The default setting is [Off].

When the setting is On, the width will be 81/2 inches.

Append CR to LF

When set to On, a carriage return will follow each line feed: CR=CR, LF=CR-LF, FF=CR-FF.

The default setting is [Off].

Resolution

You can set the print resolution in dots per inch.

The default setting is [600dpi Fast].

• p.109 "Accessing User Tools"
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7. Appendix

Specifications
This section contains the machine's electrical and hardware specifications, including information about its
options.

Printer

Component Specifications

Resolution 600 dpi  600 dpi

Printing speed

Type 1

• Color: 20 ppm

• B&W: 20 ppm

Type 2

• Color: 25 ppm

• B&W: 25 ppm

• Color: 20 ppm

• B&W: 20 ppm

(A4 , 81/2 "  11 " , plain paper)

Printing speeds depend on the machine. Check which type of
machine you have. See About This Machine.

Interface Standard:

• Ethernet interface (100 BASE-TX/10 BASE-T)

• USB 2.0 Type A/B

Network protocol TCP/IP(IPv4, IPv6), IPX/SPX

Printer language Standard: RPCS

Option: PCL 5c/6, PictBridge

Fonts PCL 5c/6:

45 Intellifonts, 13 International fonts.
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Component Specifications

Memory 512 MB

USB Interface (Standard) • Transmission spec.

USB 2.0 Standard

• Connectable Device:

Devices corresponding to USB 2.0 Standard

Supported Operating System Windows 2000/XP/Vista, Windows Server 2003/2003
R2/2008

Scanner

Component Specifications

Scan method Flatbed scanning

Image sensor type CCD Image Sensor

Scan types Sheet, book

Interface USB interface, Ethernet interface (10BASE-T or 100BASE-TX)

Maximum scan size 297  432 mm / 11.6  17.0 inches (A3, 11  17 inches)

Scan sizes that can be detected
automatically

• Exposure glass

A3 , B4 JIS , A4 , B5 JIS , A5 , 81/2 "  13
" , 81/2 "  11 "

11"  17 " , 81/2 "  14 " , 81/2 "  11 " ,
51/2 "  81/2 "

• ADF

A3 , B4 JIS , A4 , B5 JIS , A5 , 11"  17
" , 81/2 "  11 " , 81/2 "  13 "
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Component Specifications

A3 , A4 , 11"  17 " , 81/2 "  14 " , 81/2 "
 11 " , 51/2 "  81/2 " , 10 "  14 " , 71/4 "
 101/2 "

Resolution 600 dpi  600 dpi

Variable range of scan resolution Setting range: 100 dpi - 1200 dpi

Supported Operating System Windows 2000/XP/Vista, Windows Server 2003/2003
R2/2008

When Using as a TWAIN Scanner

This section explains the relationship between resolution and scan size when using the machine as a TWAIN
scanner.

To specify the scan area or resolution on the machine you are using as a network TWAIN scanner directly,
see the TWAIN driver Help.

• Certain original types and resolution settings can reduce scanning quality.

If [Binary(Text)], [Binary(Photo)], [Gray Scale], [8 Colors], or [8 Colors(Photo)] is selected in
[Col./Grad.:]

The scan size determines the maximum possible resolution.

Refer to the table below for the maximum resolution available for each scan size.

Scan size and maximum resolution

Scan size Maximum resolution (dpi)

A3, 11 "  17 ", B4 600

Legal (81/2 "  14 "), 81/2 "  13 " 700

A4, Letter (81/2 "  11 ") 800

B5 900

A5, B6, A6, A7, 51/2 "  81/2 " 1200
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If [16770K colors] is selected in [Col./Grad.:]

Scan size and maximum resolution

Scan size Maximum resolution (dpi)

A3, 11 "  17 ", B4 400

Legal (81/2 "  14 "), 81/2 "  13 " 500

A4, B5, Letter (81/2 "  11 ") 600

A5, 51/2 "  81/2 " 800

B6 900

A6, A7 1200

• Enter A7 size directly.

• A7 (74 mm/2.9 inches × 105 mm/4.1 inches)

7. Appendix
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Trademarks
Microsoft®, Windows®, Windows Server®, and Windows Vista® are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.

Adobe, Acrobat, Acrobat Reader, Adobe Reader and Reader are either registered trademarks or
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or countries.

IPS is a trademark or registered trademark of Zoran Corporation and/or its subsidiaries in the United States
or other countries.

Monotype is a registered trademark of Monotype Imaging Inc.

NetWare, IPX, IPX/SPX are either registered trademarks or trademarks of Novell, Inc.

PCL® is a registered trademark of Hewlett-Packard Company.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all right to those marks.

The proper names of the Windows operating systems are as follows:

*The product names of Windows 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

*The product names of Windows XP are as follows:

Microsoft® Windows® XP Professional

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Media Center Edition

Microsoft® Windows® XP Tablet PC Edition

*The product names of Windows Vista are as follows:

Microsoft® Windows Vista® Ultimate

Microsoft® Windows Vista® Business

Microsoft® Windows Vista® Home Premium

Microsoft® Windows Vista® Home Basic

Microsoft® Windows Vista® Enterprise

*The product names of Windows Server 2003 are as follows:

Microsoft® Windows Server® 2003 Standard Edition

Microsoft® Windows Server® 2003 Enterprise Edition

Microsoft® Windows Server® 2003 Web Edition

Microsoft® Windows Server® 2003 Datacenter Edition
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*The product names of Windows Server 2003 R2 are as follows:

Microsoft® Windows Server® 2003 R2 Standard Edition

Microsoft® Windows Server® 2003 R2 Enterprise Edition

Microsoft® Windows Server® 2003 R2 Datacenter Edition

*The product names of Windows Server 2008 are as follows:

Microsoft® Windows Server® 2008 Standard

Microsoft® Windows Server® 2008 Enterprise

Microsoft® Windows Server® 2008 Datacenter
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